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Overview 

RefWorks 2.0 is a web-based application designed to manage bibliographic references. This 

detailed guide will demonstrate how to: import references from a variety of sources; manage them 

within RefWorks; create bibliographies and insert formatted citations into documents. 

Please note that RefWorks is only available to staff and students of St George’s, University of 

London and the Faculty of Health, Social Care and Education. 
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Introduction 
 

RefWorks 2.0 enables you to: 

 Collect and store bibliographic references (i.e. details such as author and title about books, 
journal articles etc.) by downloading from web-based data services, or by entering 
manually. 

 Organise your references by storing them in online folders. 

 Insert formatted citations and bibliographies in your documents. 
 

As RefWorks 2.0 is web-based, you can use it from any PC with internet access and it is 

compatible with most browsers. However, it is recommended that you use RefWorks 2.0 in the 

Firefox browser. You can check compatibility information here: 

https://www.refworks.com/refworks2/help/Compatibility.htm  

The versions of RefWorks and Write-N-Cite in this training guide are based on those available in 

the SGUL computer rooms. 

Accessing RefWorks 
 

To access RefWorks: 

 Go to http://www.refworks.com/refworks  

 Click “My Institution’s Credentials (Shibboleth)” 

 Scroll down the alphabetical list to find St. George’s, University of London 

 Enter your St George’s username & password at the SGUL Shibboleth page 

First time use - registration 
 

The first time you use RefWorks you will need to create an account. Log in as instructed above 

and you will be prompted to fill in the registration form.   

After registering you will see your new RefWorks account. You will also receive a confirmation 

email. Next time you login it will take you directly to your references. 

 

 

 

 

 

 

 

 

 

https://www.refworks.com/refworks2/help/Compatibility.htm
http://www.refworks.com/refworks
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Importing references of online sources 
 

A powerful and quick way to build your collection of references without having to re-type is to 

import them, after having performed a search using a database.  

There are several ways to do this including: 

 Use a specialised search interface such as Hunter to find references and perform a direct 

export to RefWorks in one step. Other interfaces that provide direct export are Ovid, 

EBSCOhost, BioMed Central and ScienceDirect. 

 Not all searchable databases allow you to perform a direct export. In this instance, you 

must save the references to an intermediary file, usually a .txt file, and then import the .txt 

file into RefWorks. PubMed (page 9), Web of Science (page 10) and the Cochrane Library 

(page 11) work in this way. 

 Use the RefWorks search feature to search a Library catalogue and perform a direct import 

(page 11). 

 Google Scholar will perform a direct export to RefWorks one reference at a time (page 12). 

 As a default you only see the Harvard- FHSCE & SGUL & Vancouver output styles listed 

under ‘St George’s Specific’. Some of the more common output styles are also listed. 

Hundreds are available and to add styles to this list, select Tools menu, Output Style 

Manager. 

 

When importing references to RefWorks, you may be prompted to choose a version of the 

software: 

 

 

 

 

 

 

 

 

 

 

 

RefWorks 2.0 is also known as Legacy RefWorks. Make sure you select the correct version before 

proceeding. You can remember your selection by ticking the box at the bottom of the screen. 
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Import references using Hunter 
 

You can export your article references directly into RefWorks in one step.  

Note: These instructions assume that you are familiar with performing a search using Hunter. If 

not, please refer to the guides on the Library help pages: http://library.sgul.ac.uk/help  

 Go to the Library Homepage http://library.sgul.ac.uk  

 Click Hunter on the left-hand side or use the Hunter toolbar in the middle of the page. 

 Perform a search and save some articles to your e-Shelf. 

 Click on the link to e-Shelf to see your saved citations. Make sure you login using your SGUL 
user name and password if you wish to save these for later. 

 Tick the box beside the citations you wish to export. 

 Click on the three horizontal dots above your saved items and select Push to RefWorks 
 

 

 
 

A second browser window should open with RefWorks and an Imported References box. 

Click on View Last Imported Folder to see the citations in RefWorks. 

*IMPORTANT* 

Book citations can also be imported into RefWorks, however if there is more than one author 

their names may have to be entered into citations and bibliographies manually. This will not be 

necessary if there is just one author. 

 

 

 

Remember: Each time you import to the Last Imported folder, its previous 

content is cleared and moved into the ‘Not in folder’ list.

 

http://library.sgul.ac.uk/help
http://library.sgul.ac.uk/
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Import references using Ovid and Export feature 
 

Some search interfaces have direct export buttons, so that you can export your references directly 

and import into RefWorks in one step.  

Note: These instructions assume that you are familiar with performing a search using Ovid. If not 

look at the Library Homepage for help: http://library.sgul.ac.uk/help  

 Go to the Library Homepage http://library.sgul.ac.uk  

 Click on the link to Databases. 

 Select the Medline database (via Ovid). 

 Perform a search and select some citations. 

 Click the Export option just above the results list. 

 

 From the Export to drop down list select RefWorks. 

 Click on Export Citation(s). 

 A second browser window should open with RefWorks and an 

Imported References box. 

 Click on View Last Imported Folder to see the citations in 

RefWorks. 

 

 

 

 

Remember:  

 You may be prompted to select a version of RefWorks to import your references to. Make 

sure you select ‘Legacy RefWorks’. 

 Each time you import to the Last Imported folder, its previous content is cleared and moved 

into the ‘Not in folder’ list. 

 

 

 

 

 

 

 

 

http://library.sgul.ac.uk/help
http://library.sgul.ac.uk/
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Import references using EBSCOhost and Direct Export feature 
 

Import references using EBSCOhost and Direct Export feature 

As with Ovid, you can export your references and directly import into RefWorks in one step.  

Note: These instructions assume that you are familiar with performing a search using EBSCOhost. 

If not look at the Library Homepage for help: http://library.sgul.ac.uk/help 

 Go to the Library Homepage http://library.sgul.ac.uk 

 Click on the link to Databases. 

 Select the CINAHL Plus database. 

 Perform a search and click on the ‘add to folder’ icon        to add some references:   

 Click on the Folder tab at the top of the screen 

 Select some references, and click the Export icon.  

 

 In Export Manager, select Direct Export to RefWorks. 

 Click Save.  
 

 

 Your records should appear in the Last Imported Folder in RefWorks. 
 

Remember:  

 You may be prompted to select a version of RefWorks to import your references to. Make 

sure you select ‘Legacy RefWorks’. 

 Each time you import to the Last Imported folder, its previous content is cleared and moved 

into the ‘Not in folder’ list. 

 

 

 

http://library.sgul.ac.uk/help
http://library.sgul.ac.uk/
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Import references from Internurse and Intermid 
 

 Go to the Library Homepage http://library.sgul.ac.uk 

 Click on the link to Databases. 

 Select the Internurse or Intermid database and perform a search. 

 Select a result you wish to export and once in the article view, select the Tools button.  

 

 From the drop-down menu select download citations. Then select Ref 
 

 
 

 You will be taken to another page, click on the link to Submit data to RefWorks. 

 

Remember:  

 You may be prompted to select a version of RefWorks to import your references to. Make 

sure you select ‘Legacy RefWorks’. 

 Each time you import to the Last Imported folder, its previous content is cleared and moved 

into the ‘Not in folder’ list. 

 

http://library.sgul.ac.uk/
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Import references from PubMed by downloading a text file and importing 
 

Note: These instructions assume that you are familiar with performing a search using PubMed. If 

not look at the Library Homepage for help: http://library.sgul.ac.uk/help  

 Go to PubMed (www.pubmed.gov) 

 Perform a search and select the references you want to export. 

 Click Send to and select File.  Under Format change Summary (text) to MEDLINE.  Click 

Create File.  If prompted, choose to save the file to a location, on site it may automatically be 

saved in your H: drive. 

 

 

To import the PubMed text file into RefWorks 

 From the References menu in RefWorks click on Import.  Or use the quick link on the right-
hand side.  

 

 

 
 
 
 

 

 Use the From Text File option. 

 Select NLM PubMed as the Import filter/data source. 

 Click Browse button to locate your saved .txt file. 

 Leave Encoding as the default setting. 

 Click the Import button. 

 Choose a folder to import your references into; they will also go into the Last Imported 
Folder until you import your next set of references. 
 
 

 

 

http://library.sgul.ac.uk/help
http://www.pubmed.gov/
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Import references from Web of Science by downloading a text file and importing 
 

 Go to the Library Homepage http://library.sgul.ac.uk 

 Click on the link to databases. 

 Select Web of Science database and perform a search. 

 Select some citations, click on the Save to… pull down menu and select Save to Other 

File Formats. 

 

 

 

 In the pop-up box select the File Format Other Reference Software and click send. 

 Click Save. 

 This will open a 'File Download’ dialog box. It will prompt “Do you want to open or save this 

file?” Select Save. 

 Select a location, enter a file name if you wish, and save the file. 

 

To import the text file into RefWorks: 

 Select the References menu in RefWorks, and then Import. 

 Use the From Text File option. 

 Select Thomson Reuters as the import filter / data source. 

 Select Web of Science as the database. 

 Click Browse button to locate your saved .txt file, click Open. 

 Click the Import button to import your references. 

 Your records should appear in the Last Imported Folder. 

http://library.sgul.ac.uk/
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Import references from The Cochrane Library by downloading a text file and 

importing into RefWorks 
 

 Go to http://www.cochranelibrary.com    

 Perform a search. 

 Select some citations. 

 Click Export Selected Citations 

 Select Save to RefWorks then Download 

 
 This will open a 'File Download’ dialog box. It will prompt “Do you want to open or save this 

file?” Select Save. 

 Select a location, enter a file name, and save the file. (Make sure file type is text). 

To import the Cochrane text file into RefWorks 

 Select References menu, then Import. 

 Use the From Text File option. 

 Select RIS Format as the import filter / data source. 

 Select RIS Format as the databases source. 

 Click Browse button to locate your saved .txt file, click Open. 

 Click the Import button to import your references. 

 Your records should appear in the Last Imported Folder. 

 

Import references from a Library catalogue 
 

 In RefWorks, select the Search menu, and then Online Catalogue or Database. 

 Select a catalogue. 

 Enter some search terms in the Quick Search box. 

 Alternatively, click on Advanced Search to search by author, title etc. 

 Use the + icon to search additional fields. 

 Click Search.  Search results will be displayed as below. 
 

• Select your references, click 

Import and OK to confirm. 

• Close the Search Results 

window 

• Your records should appear 

in the Last Imported Folder. 

 

 

Note: Not all databases and catalogues listed will import effectively using this option. 

 

http://www.cochranelibrary.com/
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Import references from Google Scholar 
 

 Go to http://scholar.google.com 

 Click on the link to Settings (in the toolbar above the Google Scholar logo) 

 At the bottom of the page where it says Show links to import citations into, select 
RefWorks from the drop down menu. 

 Click on Save. 

 Search results will now display an Import into RefWorks link.  

 Perform a search. 

 For one of the search results, click the Import into RefWorks link. 

 This will import your chosen result into RefWorks (you may need to login to RefWorks). 

 Click on Last Imported Folder to view your record from Google Scholar 
 
Note:  

 You can only import one reference at a time from Google Scholar 

 Consistent data such as title, author, year, etc. may not always exist in your results, but if 

information is present, it will be imported into RefWorks 

Remember:  

 You may be prompted to select a version of RefWorks to import your references to. Make 

sure you select ‘Legacy RefWorks’. 

Import references from PEDro using “Import data from the following text” in 

RefWorks 
 

 Go to http://www.pedro.org.au    

 Perform a search and select some references.  

(Be aware that it does not give a clear indication that a record has been selected.) 

 Choose the references you wish to import by clicking on Select. 

 Click on Display Selected Records. 

 Highlight and copy the records (right-click and copy or Ctrl+C). 

 In RefWorks under the References menu click on Import. 

 

 

      Click on From Text. 

      Select PEDro as the  

        Import Filter/Data Source.  

      Paste text into the box. 

      Select a folder or leave as  

        Last Imported. 

      Click Import. 

 

 

 

 

http://scholar.google.com/
http://www.pedro.org.au/
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Adding a reference manually 
 

Most of the time, your references can be downloaded into your database from online resources. 

However, there will also be references that require keyboard entry such as theses and 

dissertations. 

Add a new reference 
 
Click the New Reference button.  
 

 In Fields used by select an output style, such as Harvard-FHSCE & SGUL or Vancouver.  
(Note that this is just an aid for data entry, you can still choose to use other referencing 
styles when generating a bibliography). 

 

 If you do not specify where to save the reference, it will be saved in the ‘Not in Folder’ 
folder. 

 

 Select the Reference Type, for example journal, book, thesis, dissertation etc. 
 

 
 
 

 Enter the information as required by your chosen style.   
 

 The format for the Author field must be last name first followed by a comma, first name (or first 
initial followed by a period), and middle initial followed by a period. Each entry must be 
separated by a semi-colon. For example:  Smith, R.; Jones, Robert K.; Adams, Mary 

 

 You may enter additional information, by clicking on Additional Fields.     
 

 To save the reference click Save Reference then close the Add New Reference window. 
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Managing your references 
 

When you log in to RefWorks all your references will be displayed.   

Use the Sort by drop-down list to change the order in which your references are displayed. 

 

You can display different levels of detail using the Change View options: 

 Standard view 

 One line/Cite view 

 Full view 
 

Viewing a reference 
 

To view the complete record for a reference, click on the magnifying glass icon  above the 

reference.  
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Editing a reference 
 

You may need to make changes to a reference, for example, to add or remove information or to 

correct an error. 

Make sure you are either in Standard View or Full View. Click on the edit icon  above the 

reference you want to edit. After you have made the changes, remember to save the reference. 

Create a new folder 
 

In RefWorks, you can use folders to organise your references. 

To create a new folder: 

 Click on the New Folder button:       

 Enter the folder name and click Create. 
 

Move references to a folder 
 

        At first, your references will not be in a folder. To move references into a folder, or from one 

folder to another: 

 Select the references you want to move. 

 Move mouse pointer to the folder icon and select the folder you want to move the reference to. 
When you move references between folders it is a copy process; i.e. the reference remains in 
the original folder and the new folder.  

 

 

 

  

 

Remove from folder 
 

        Use this option to clear selected references from a folder. This will remove a reference from 

just this folder. If the reference is in any other folder it will remain. If you use ‘Remove from folder’ 

and the references are only in one folder, RefWorks will move them to a system folder called Not 

in Folder. 

 

Delete – to permanently remove references from all folders 
 

       This option will permanently delete a reference from your database – i.e. from all folders. Any 

references you delete are automatically moved to a system folder called Deleted References (in 

the View menu). The green restore icon shown in the tool bar there allows you to reinstate a 

reference but after 30 days they are permanently deleted. 
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View and organise folders 
 

To view your folders, rename a folder or delete a folder: 

 Click on the Organize & Share Folders tab. 
 

 

 

 

 

 

 

 Then click on the folder icon and select an option from the drop-down menu. 
 

 

 

  

 

Using Global Edit 
 

The Global Edit feature allows you make changes to multiple records at the same time, such as 

adding the same information to a particular field in selected references. 

To perform a Global Edit: 

 Select the references you wish to edit (you can skip this if you want to make changes to all 
references in a list or folder). 

 Click Global Edit  

 Choose what you want to do: Add, Move, Delete or Replace. 

 Specify a field and make the appropriate changes. 
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Generating a bibliography in RefWorks 
 

You can create a bibliography (an ordered list of books, articles etc.) from references in RefWorks. 

To generate a bibliography for selected references, first add the references you want to include to 

My List (a temporary folder).  Click on the star icon  next to an individual reference in standard 

view, or select references and use the move to folder option. 

 Choose the set of references to include; you can select all in the database, those in My List or 
specify a folder. 

 Click on Create Bibliography. 

 Select the output style required, such as Harvard- FHSCE & SGUL. 

 Choose a file type (for example, Word or Rich Text Format (RTF). 

 Click on Create Bibliography button in the bottom right of the window. 

 A list of formatted references will be created in a file for you to save, print, email as required 
(you may need to allow the pop-ups).  
 
  

 

 

 

 

 

 

 

 

 

 

Note: If you want to create a reference list for articles cited in a document, use the method 

described in the next section: Inserting citations into Word. 

Inserting citations into Word documents 
 

RefWorks allows you to insert citations and create bibliographies within a Word document.  There 

are two ways to do this: 

 Using the Write-N-Cite 4 add-in. 

 By copying and pasting the citation using One Line/Cite View feature in RefWorks. 
 

Write-N-Cite is a small separate program which must be installed on the PC you are using. It is 

freely available and can be downloaded from within RefWorks.  It is easier to use the Write-N-Cite 

utility, but the other option is useful if Write-N-Cite is not available. 

Note: Write-N-Cite 4 is installed in St George’s Library Computer rooms and at Kingston University. 
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How to install Write-N-Cite 
 

 Log in to RefWorks. 

 Select Tools menu, select Write-N-Cite. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
  
 
 
 
 

 
 

 

 Various options are available. Check the compatibility with your operating system and version 
of Word. Click Other Versions for Mac installations. 

 If you have installed a previous version of Write-N-Cite you will have to uninstall it first before 
installing Write-N-Cite 4.  

 Download and install on your computer following the on-screen instructions. 
 

 

Please note: Currently, Write-N-Cite for Mac does not work with Word 2016, only 

Word 2008 and Word 2011 for Mac 
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Inserting Citations and bibliography with Write-N-Cite 4 
 

 Keep RefWorks open. 

 Try if yourself: Open a Word document and type 
the following text:  
 
“This document will show you how to insert single 
and multiple citations and how to create a 
bibliography.” 
 

 Click on the RefWorks tab at the top of your word 
document. 
 

 Click on the Log in option from the RefWorks 
menu and select ‘Log in from my institution’. 
Search for St. George’s, University of London and 
enter your SGUL username and password. 
 

 In your Word document, place your cursor in the 

text where you want to insert the citation. 

 

 Click on the link to Insert Citation, select New. A 

box will appear showing you your folders and 

references.  Select the reference you want to cite 

then click on OK. 

 

 To generate a bibliography first select a style. The style drop-down menu is on the top left-

hand side of the menu. Use the drop down box to select Other Styles. This will give you the 

option to choose Harvard FHSCE & SGUL or any other referencing style you require. 

 

 Place your cursor in the text where you want to inset the bibliography. Click on the 

Bibliography Options then select Insert Bibliography.  

 

 Repeat the previous step using a different output style.  The citations and bibliography will 

be re-formatted in the new style. 

Note: There are hundreds of output styles available; as a default you only see the Harvard- 

FHSCE & SGUL and Vancouver output styles listed for St George’s. To add styles to this list, log 

into RefWorks, and select the Bibliography menu, then Output Style Manager. 

Edit citations 
 

Inserted and formatted citations do not always appear exactly as you want them to.  You may want 

to add a prefix or suffix such as: (Also see Baker 2009) or (March 2003 p.13) 

You may also want to exclude the author name if you mention it in the sentence, you can do this 

manually.  

Note: If you notice incorrect details such as a spelling error in the author’s name or the wrong 

year, you need to go back to your RefWorks database, make the change there and re-insert the 

citation. 
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Preparing the document to send to another recipient such as publisher 
 

In order to provide this Write-N-Cite feature, field codes are inserted in your document where a 

citation or bibliography is generated. Generally, it is preferable to provide a copy of your document 

without these codes. To do this, use the Remove Field Codes option.  

Remember: 

 Save a copy of the document with the field codes.  Without these codes you will not be able 

to use the Write-N-Cite feature to edit your work if there is a problem or you need to 

generate a new document with a different referencing system. 

 Make a copy of this document, remove the field codes and send this document to the 

recipient. 

 If you need to make changes, always edit this original document with the codes. 

To remove the field codes: 

 In Word, select the RefWorks tab at the top of the screen. 

 Click Remove Field Codes. This will remove all the coding from the document. 

Remember before starting this process, it is strongly recommended that you save a copy of the 

document with a different name. Once removed, the citations and bibliography can no longer be 

updated or reformatted with RefWorks. 

Insert citations without Write-N-Cite 
 

 Try it yourself: Open a new Word document and type the following text: 
  
“This document will show you how to create a bibliography when Write-N-Cite plug in is not 
available.” 
 

 Login to RefWorks. 
 

 Display a reference in RefWorks to insert in your document. 
 

 Click the Cite icon above the reference you want to insert:       
 

 The Citation Viewer window will open with the citation 
number. Select everything in the window and copy to the 
clipboard (Ctrl + C). 
 

 In your Word document, place the cursor where you 
want the citation to appear in your text and paste  
(Ctrl + V) this citation into your Word document. 
 

 In the Citation Window click Clear. 
 

 Repeat the previous steps with another citation, or multiple citations, placing them 
elsewhere in the text. 
 

 Save your document as RWtraining and close it. 
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 In RefWorks, click Create Bibliography. 

 Choose Harvard – FHSCE & SGUL 

 Click on Format Paper and Bibliography. 

 Browse to your Word file (RWtraining) as the Document to Format. 

 If your document does not download automatically, click the Download it link and then 
Save. 
 

Note: Remember to always work and edit in the original document with field codes.  You can 

save as many final documents, at various stages and in as many styles as you wish. 

As a default you only see the Harvard- FHSCE & SGUL & Vancouver output styles listed under St 

George’s Specific. Some of the more common output styles are also listed. Hundreds are available 

and to add styles to this list, select Tools menu, Output Style Manager. 

Using the Harvard – FHSCE & SGUL output style 
 

The Harvard - FHSCE & SGUL output style has been put together to help you reference your books, 

journals and websites correctly.  

 

You should always check your references to make sure they correspond to the correct 

style before submitting your work. 

 

Some of the main points to look out for are: 

 If your citation includes a page number this will have to be added manually. 

 Most references that are imported electronically will be referenced correctly. However, if you 
are referencing a chapter, section or part of a book, you will need to enter the information 
manually into RefWorks.   

 Check corporate authors are referenced properly, especially if the item has been imported 
electronically.  

 

How to backup and restore your RefWorks database 
 

As you would make a backup of any important files, it is a good idea to make a regular backup of 

your RefWorks database. In the event of any problem with your database, you can restore from the 

backup.  

If you need to move your RefWorks database to a different Shibboleth account, you should use the 

Backup & Restore feature. 

Go to the Tools menu and select Backup & Restore. 
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Backing up your existing RefWorks account 
 

 Select the information you want to backup and then click on Perform Backup. 

 An RWB format file will be automatically saved for you, you will not be able to open, read or 
amend it. This file can be restored into your RefWorks account. 

 
 

Restoring your RefWorks account 
 

 Select the information you want to restore, use Browse… to locate the backup file and then 
click on Perform Restore. 
 

 

 

 

 

 

 

 

 

 

NOTE: If a box opens informing you that you need to choose a program to open your backed up or 

restored document, browse your computer to choose one. Internet Explorer is effective. 
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Using Export and Import References 

Export from RefWorks 
 

You can export a copy of all or part of your database to a different application, such as Reference 

Manager or EndNote, or you may want to share references with someone else using RefWorks. 

 Select the references you wish to export. 

 Select References menu, Export, or use the quick access link on the right. 

 Select the Export format you want, then click Export References. 

 Save the resulting file in whichever format you prefer (Word, Notepad) 
 

Export Format allows you to select the format you want to create. The options are: 

 Bibliographic Software (such as EndNote, Reference Manager, ProCite) - saves the 

database in a tagged format that can be imported into another bibliographic management 

program. 

 BibTex – RefWorks ID Saves the database in the file format for use with the LaTeX 

document preparation system 

 Citation List - creates a list to use when writing your paper offline. The format includes the 

RefID, Authors Primary, Title Primary, and Publication Year only.  

 RefWorks Tagged Format - use this format for sharing data with other RefWorks users. 

Please note that any folder structure is not maintained.  

 Tab Delimited - saves all your data in an organized manner with each field separated by a 

tab. It may then be loaded into other programs that are designed to read this type of format.  

 RefWorks XML Format is used to create your export file in an XML format.  

Import into RefWorks 
 

You can also bring in references from other sources outside RefWorks (such as EndNote, Reference 

Manager), provided they are in one of the supported formats described above.   

 Select References menu and then Import, or use the quick access link on the right. 

 Select the appropriate Import Filter/Data Source and Database. 

 Select a Text File using the Browse… to where your text file is saved. Click Import. 

 The references will be imported into the Last Imported Folder as well as any folder you have 
selected. 

Further help and support 
 
Support from RefWorks: 

 Within RefWorks go to Help > Launch Help File to view the Online Help manual.  

 Support pages including Tutorials and links to the RefWorks Community: 
http://refworkscommunity.ning.com/page/main-1  

 RefWorks YouTube Channel: http://www.youtube.com/proquestrefworks 

Library Contacts: 

 Email your Liaison Librarian: liaison@sgul.ac.uk  

 Visit the Research Enquiries Desk for drop-in help. (Mon-Fri, 11am-4pm subject to change) 

 Try our RefWorks and Reference Management guide: http://libguides.sgul.ac.uk/refworks  

http://refworkscommunity.ning.com/page/main-1
http://www.youtube.com/proquestrefworks
mailto:liaison@sgul.ac.uk
http://libguides.sgul.ac.uk/refworks

